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Experience the 2007 Microsoft Office System 
The 2007 Microsoft Office system includes programs, servers, services, and solutions designed to 
work together to help you succeed. New features in the 2007 release enhance how employees can 
work with one another, partners, and customers, and how organizations capture and use 
information. Updated packaging options allow you to have more flexibility than ever before to 
adopt the specific technologies and solutions that best meet your business and personal needs. 
Learn more about the 2007 Microsoft Office System at http://office.microsoft.com 

Tips & Tricks 
Deliver Better Results Faster 

Creating Professional Documents Effortlessly by Using Office Word 2007 

• Command Tabs – The traditional menus and toolbars have been replaced by a set of 
Command Tabs located in what is called the Ribbon. Presented graphically, 
Command Tabs display the commands that are most relevant for each of the task 
areas in the application. For example, Office Word 2007 has Command Tabs for 
writing, inserting, viewing, and other tasks. You can double-click a Command Tab to 
hide or reveal the Ribbon as needed. Of course, the traditional dialog box interfaces 
are still available for those who want a greater degree of control over the result of the 
operation. 

• Galleries and Live Preview – You can click a Gallery on the Command Tabs to see 
a Live Preview of an editing or formatting change before that change is actually 
applied. 

• The File Button – The File button has replaced the File menu and contains many of 
the standard file-related commands. 

• The Mini Toolbar – When working in the content of a document, you can use the 
common formatting items in the Mini Toolbar to limit use of the Command Tabs. 

• Contextual Command Tabs (Tables) – Certain sets of commands are relevant only 
when objects of a particular type are being edited. For example, the commands 
for editing a table in Office Word 2007 are not relevant until a table exists in a 
document and the user is focusing on modifying it. Office 2007 features Contextual 
Command Tabs that appear only when they are needed and remain out of the way 
when they are not. Click the Table group on the Insert tab. Click the table to see the 
Table Tools contextual command tab. 

• Quick Styles – By using the Quick Styles feature, you can change how entire 
documents look with a single click. You can modify fonts, colors, margins, table 
formatting, and other elements by simply choosing a different Quick Style. You can 
also create your own custom Quick Styles. Click the Styles group on the Home 
command tab. 
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• Global Document Changes – Global document changes are also easier to make in 
Office 2007. For example, you can use the Margins Gallery to visualize and apply 
margin changes with one click. Document themes provide the foundation for the 
overall look of your document. The theme specifies the major and minor fonts used 
in the document, the color palette for the document, and the effects used for shapes, 
charts, and diagrams inserted into the document. Click the Page Setup command tab 
for global document options. 

• Building Blocks – Applying document building blocks such as headers and footers is 
also done with a click. Relevant options for customizing these components are 
revealed via the Contextual Command Tab only when needed. Click the Header & 
Footer group on the Insert command tab.  

Analyzing Information by Using Office Excel 2007 

• Command Tabs – Office Excel 2007 has a unique set of Command Tabs useful for 
spreadsheet work such as creating worksheets, working with formulas, managing 
data, and other tasks. 

• Spreadsheet Capacity – Office Excel 2007 delivers greater spreadsheet capacity—1 
million rows by 16,000 columns—to facilitate working with tremendous amounts of 
data. You no longer have to use many different spreadsheets to support your data.  

• Page Layout View – You can also use the new Page Layout View to work with your 
spreadsheets as they will appear on the printed page. On the View tab, in the 
Workbook Views group, click Page Layout View. 

• Excel Tables – Enhancements in Office Excel 2007 help you assemble data into a 
table with just a few clicks. Simply choose Format as Table in the Styles group on the 
Home command tab and Office Excel 2007 automatically labels column headings, 
creates AutoFilters, and displays other relevant tools. When you need to expand the 
table to accommodate more data, Office Excel 2007 quickly expands the table using 
the proper format. 

• Formulas – New formula enhancements enable you to build formulas based on 
column headers instead of cryptic cell names. Formulas can be automatically copied 
down the entire column. 

• Conditional Formatting – You can apply conditional formatting more easily and 
identify trends by using colored gradients, data bars, and icons. In the Style group on 
the Table Tools command tab, click Conditional Formatting. 

Using Charts to Communicate Information 

• Office 2007 Charting Engine – With accessible charting tools available from the 
newly redesigned interface of the Microsoft Office system, you can create 
professional-looking charts with just a few clicks. Use the Chart Tools Contextual 
Command Tab to format axes, titles, and other chart labels or add visual 
enhancements such as 3-D, shadows, and glow. Click the Charts group on the Insert 
command tab.  



Microsoft Office System 
Tip Sheet 

 
 
 

3 

Creating Dynamic Presentations 

• Command Tabs – Office PowerPoint 2007 has a unique set of Command Tabs 
useful for presentation tasks, including designing slides, working with animations, 
and customizing the slideshow experience. 

• Diagrams – New graphical capabilities help you easily create diagrams from scratch 
or change an already determined set of bullet points into an appealing and effective 
diagram. These new diagramming capabilities are complemented by updated effects, 
presented in contextual menus as you work with the diagram. All the diagrams are 
dynamic and can be adapted to your needs, so you are not confined to static and 
unmanageable graphics. Right-click the desired bullet and select Convert to 
SmartArt. Use the SmartArt contextual command tabs to customize the diagram. 

• Themes –PowerPoint themes simplify the process of creating presentations. Simply 
select the theme you want, and Office PowerPoint 2007 does the rest. With one click, 
the background, text, graphics, charts, and tables all change to reflect the theme you 
have selected, helping to ensure that all elements in your presentation complement 
one another. Click the Themes group on the Design command tab. 

Managing E-Mail, Notes, and Tasks 

• Command Tabs – Opening an e-mail message or other Outlook item reveals the 
now familiar Ribbon and selection of Outlook-specific Command Tabs. 

• Instant Search – With new and powerful integrated Instant Search, you can quickly 
locate the information you need, whether it is in your e-mail, calendar, contacts, or 
tasks. Type in a keyword, and Instant Search quickly searches your Office Outlook 
2007 data, highlighting the locations where that search term appears. Instant Search 
even searches for keywords within e-mail attachments. You also have the flexibility 
to create queries with different criteria, such as date, sender, color categories, and 
mail importance, and Instant Search finds and delivers the results. 

• Attachment Previewer – With the new Attachment Previewer, you can view your 
attachments with one click directly from within the reading pane. Click Preview File 
in the preview pane.  

• Color Categories –New color categories give you a quick, visual way to customize 
and distinguish items from one another, making it easy to locate information. You 
can add the same color category to mail, calendar, or task items so that you can easily 
locate all items from a project at a glance. When you need to find the information 
later, you can search and sort by color categories to quickly identify what you are 
looking for. On the Message tab, in the Options group, click Categorize, and then 
select a Category. 

• To-Do Bar –The new To-Do Bar integrates your tasks, e-mail messages flagged for 
follow-up, upcoming appointments, and calendar information in one convenient 
place. It also includes tasks from the Office OneNote 2007 note-taking program, 
Microsoft Office Project 2007, and Microsoft Windows SharePoint Services Web 
sites. 
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• Flagging Mail as Tasks – With the Flagging Mail as Tasks feature, you can create a 
task from an e-mail message in one simple step. Simply right-click to flag your 
message and designate a date for completion. The item is then added to your To-Do 
Bar and the due dates are integrated automatically into your calendar. 

• Daily Task List – Office Outlook 2007 integrates tasks on the calendar in the Daily 
Task List so that you see them displayed beneath your daily appointments and 
meetings. To allot time for working on a task, you simply drag the task onto your 
calendar. 

• OneNote – You can link items in your Office Outlook 2007 calendar to meeting 
notes in Office OneNote 2007. You could easily access information about the 
meeting on your calendar by clicking through the Office OneNote 2007 interface—or 
quickly access the information in Office OneNote 2007 by clicking a link in your 
calendar. Select a Calendar item and click Notes About This Item in the toolbar. 

 

Simplify Working Together 

Sharing Your Work Confidently 

• Prepare Files for Sharing – Before sharing a document with a customer, co-worker, 
or partner, you need to make sure you can do so confidently. Office 2007 provides 
several ways to prepare files for sharing, including protecting against unauthorized 
viewing and distribution, adding a digital signature for verification, and checking 
compatibility with older versions of Microsoft Office. Click the File Button, then the 
Finish menu. 

• Document Inspector –Document Inspector removes personally identifiable 
information, comments, and tracked changes from documents. It can also search for 
and remove hidden text and other types of information. Click the File Button, then 
the Finish menu. 

• Save as PDF – Office 2007 supports saving your document as a Portable Document 
Format (PDF) or XML Paper Specification (XPS) file. Now you can post your 
documents on the Internet or share them with others, knowing that other users can 
view them regardless of the type of computer or applications they are using. Click the 
File Button, then the Save As menu. 

• Mark as Final – Marking a document as Final makes the document read-only. 
Notice that all formatting tools are now disabled, which prevents unauthorized 
editing of the document. Click the File Button, then the Finish menu. 

• Share Your Files – When the document is ready, use the Send and Publish menus to 
share it with others. You can send the file via e-mail, fax it with an Internet fax 
service, or save it to a document management server. If you are making the document 
available for collaboration purposes, create a document workspace to store the 
document in a central online location. Document workspaces are made possible 
through integration with Windows SharePoint Services, a feature of Windows Server 
2003. You can use Office SharePoint Server 2007 to further extend these capabilities. 
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After a document workspace is created, you can use it to communicate with project 
participants and control document editing through a check-in/check-out procedure. 
Click the File Button, then the Share menu. 

Sharing and Reusing Presentations 

• SharePoint Slide Libraries – You can use new SharePoint Slide Libraries to give 
you one centralized storage area for all your personal or team presentations. For 
example, if you or your teammates have created a presentation and you need to use 
one or two existing slides, it is easy to insert this content into your presentation 
without ever leaving Office PowerPoint 2007. You can also choose to link slides in 
your presentation to the server version. If the server version changes, you are 
automatically prompted to update your slides. When finished, you can publish your 
new presentation to a Slide Library directly from Office PowerPoint 2007. Now other 
people can repurpose your content for their own work. On the Slides tab, in the Slides 
group, in the Add Slide list, click Reuse Slides. In the Reuse Slides pane, click Open 
a Slide Library. 

Connecting to Information by Using Offline Document Libraries and Office Groove 
2007 

• Offline Document Libraries – You can keep synchronized copies of Office 
SharePoint Server 2007 document libraries and lists within your Outlook folders, 
making it easy to organize and browse documents in these folders, just as you would 
any mail. You can work on these documents within their respective applications in 
Office Outlook 2007 at any time, even when you are offline. When you are back 
online, you can easily synchronize your changes with the server version. From a 
shared document library, click Actions on the Shared Documents toolbar, then click 
Connect to Outlook. 

• Groove Workspaces – Office Groove 2007 is a collaborative environment that 
enables teams to work together more effectively, regardless of network boundaries. 
Teams using Office Groove 2007 work together in collaborative workspaces that 
place all team members, communications, tools, and information in one convenient 
location accessible from each member’s computer. Each time you make a change—
such as updating a file, responding to a discussion, or posting some text in the 
workspace chat area—Office Groove 2007 updates your change (and only that 
change) for all the members of your workspace. If you are not online when you make 
the change, Office Groove 2007 publishes it the next time you connect. If your team 
members are not connected, they will see the change the next time they connect. 

• Groove Launchbar – The first thing you see when you start Office Groove 2007 is 
the Groove Launchbar. This easy-to-use tool helps you manage and organize all your 
Groove activities, including creating new workspaces, inviting others to workspaces, 
sending messages, monitoring workspace and contact activity, and setting your 
personal Groove preferences. 
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• Groove Files Tool – You can use the Files tool to work collaboratively with your 
teammates on almost any type of computer file. Everybody in your workspace has 
access to those folders and files. 

• Groove Discussion Tool – The Groove Discussion tool helps teams engage in a 
detailed exchange of ideas in context of the work they are doing in the workspace. 

• SharePoint Files Tool – The SharePoint Files tool offers all the capabilities of the 
Groove Files tool with the added benefit of integration with SharePoint document 
libraries. You can easily check out documents from a document library into your 
Groove workspace, collaborate on and iterate those documents among your project 
team, and then publish them back to the document library when you have finished. 
You can access and update the information in your workspaces whether you are 
connected to the network or not. 

 

Streamline Processes and Content 

Importing Forms by Using the Form Import Wizard in Office InfoPath 2007 

• Import Form Wizard – The Import Form Wizard in Office InfoPath 2007 makes it 
easy to convert Word documents and Excel workbooks into forms and to build 
structure into your information-gathering processes. Click File Design a Form, then 
click Import. 

• Design Checker – The Office InfoPath 2007 Design Checker examines the 
conversion, identifying each field and table in the form. If the wizard discovers an 
ambiguous or unsupported element in the form, it flags the element and prompts you 
to insert a proper control as a replacement. The Design Checker can also be used to 
check browser compatibility for your form. Click View Task Pane, then Design 
Checker. 

• Deploying Forms – With the InfoPath Forms Services capabilities of Office 
SharePoint Server 2007, you can deploy your compatible business forms beyond the 
corporate firewall as browser-based forms that do not require a local installation of 
InfoPath. You can also deploy forms to Office Outlook 2007 and SharePoint Form 
libraries. Click the File button, and then click Publish. 

Configuring a Document Approval Workflow 

• Create Workflow Template – With Office SharePoint Server 2007, you can take 
advantage of workflows to automate and gain more visibility into common business 
activities such as document review and approval, issue tracking, and signature 
collection. You can create a workflow template for any document in a Document 
Library. In the Details pane, click Settings, and then click Document Library 
Settings. Under the Permissions and Policies heading, click Workflow settings. 

• Start a Workflow – To start the workflow, in the drop-down list for the document, 
click Workflows. Select the desired workflow, and then click Start.  
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• Participate in a Workflow – Integration with familiar client applications such as 
Office Outlook 2007 simplifies the user experience. For example, you can be notified 
of the workflow in progress via e-mail. Click Edit this Task to open the approval 
dialog box. From here, you can open the workflow document, then approve or reject 
it, adding your comments if necessary. 

• Track a Workflow – You can track the workflow progress and view the completion 
information in the Shared Document Library. 

Configuring Information Management Policies 

• Define a Policy – Records management capabilities in Office SharePoint Server 
2007 give records managers the ability to set up a records repository according to the 
organization’s file plan. In a document library, click Settings, and then click 
Document Library Settings. In the Permissions and Policies section, click 
Information Management Policy Settings. In the Specify the Policy section, click 
Define a policy, and then click OK. 

• Auditing Policies – Auditing policies can be turned on to log all activity against a 
record library, and administrators have the ability to see reports on the usage. In the 
Auditing section, click Enable Auditing.  

• Expiration Policies – The system also provides the ability to specify an action when 
the expiration date is reached. The action either disposes the record or starts a 
workflow that can allow the records manager to take action such as moving this 
record to a long-term archive. In the Expiration section, click Enable Expiration. 

 


